Notices

Copyright Notice
© Keysight Technologies 2019
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies as governed by United States and international copyright laws.

Trademark
Bluetooth® and the Bluetooth® logos are trademarks owned by Bluetooth SIG, Inc., U.S.A. and licensed to Keysight Technologies, Inc.

Manual Part Number
U3800-90001

Edition
Edition 5, April 2019

Printed in:
Printed in Malaysia

Published by:
Keysight Technologies
Bayan Lepas Free Industrial Zone,
11900 Penang, Malaysia

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Declaration of Conformity
Declarations of Conformity for this product and for other Keysight products may be downloaded from the Web. Go to http://www.keysight.com/go/conformity. You can then search by product number to find the latest Declaration of Conformity.

U.S. Government Rights
The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Warranty
THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR OF ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT SHALL CONTROL.

Safety Information

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Environmental Conditions

The U3800A IoT Development Kit is designed to operate under the general environmental requirements stated in the table below.

<table>
<thead>
<tr>
<th>Environmental condition</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating condition:</td>
<td>0 to 40 °C</td>
</tr>
<tr>
<td>Storage condition:</td>
<td>–40 to 70 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td></td>
</tr>
<tr>
<td>Operating condition:</td>
<td>Up to 80% RH at 25°C (non-condensing)</td>
</tr>
<tr>
<td>Storage condition:</td>
<td>Up to 95% RH at 40°C (non-condensing)</td>
</tr>
<tr>
<td>Altitude</td>
<td>Up to 2000 m</td>
</tr>
</tbody>
</table>

Regulatory Information

The U3800A IoT Development Kit complies with the following Electromagnetic Compatibility (EMC) compliance and radio requirements.

**EMC compliance**

**End product**
- IEC 61326-1:2012 / EN 61326-1:2013
- EN 301 489-1 V2.1.1
- EN 301 489-17 V3.1.1

**Modules**
- EN 301 489-1 V2.1.1
- EN 301 489-17 V3.1.1 (WLAN/Bluetooth®)
RF compliance (modules)
- EN 300 328: V2.1.1 (2.4 GHz WLAN, Bluetooth®, ZigBee® wireless standard)
- EN 301 893: V2.1.1 (5 GHz WLAN)

RF health (modules)
- EN 62479:2010
- EN 62311:2008

**CAUTION**
Operate the device at least 20 cm away from the transmitter.

**NOTE**
5.15 GHz-5.35 GHz band is restricted to indoor operations only in the following countries.

<table>
<thead>
<tr>
<th>Austria (AT)</th>
<th>Belgium (BE)</th>
<th>Bulgaria (BG)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Czech Republic (CZ)</td>
<td>Denmark (DK)</td>
<td>Estonia (EE)</td>
</tr>
<tr>
<td>France (FR)</td>
<td>Germany (DE)</td>
<td>Iceland (IS)</td>
</tr>
<tr>
<td>Ireland (IE)</td>
<td>Italy (IT)</td>
<td>Greece (EL)</td>
</tr>
<tr>
<td>Spain (ES)</td>
<td>Cyprus (CY)</td>
<td>Latvia (LV)</td>
</tr>
<tr>
<td>Liechtenstein (LI)</td>
<td>Lithuania (LT)</td>
<td>Luxembourg (LU)</td>
</tr>
<tr>
<td>Hungary (HU)</td>
<td>Malta (MT)</td>
<td>Netherlands (NL)</td>
</tr>
<tr>
<td>Norway (NO)</td>
<td>Poland (PL)</td>
<td>Portugal (PT)</td>
</tr>
<tr>
<td>Romania (RO)</td>
<td>Slovenia (SI)</td>
<td>Slovakia (SK)</td>
</tr>
<tr>
<td>Turkey (TR)</td>
<td>Finland (FI)</td>
<td>Sweden (SE)</td>
</tr>
<tr>
<td>Switzerland (CH)</td>
<td>Croatia (HR)</td>
<td>United Kingdom</td>
</tr>
</tbody>
</table>
Safety compliance
- IEC 61010-1:2010 / EN 61010-1:2010

Canada
- ICES/NMB-001: Issue 4, June 2006
- ICES/NMB-003 (modules)

United States
- FCC Part 15B (modules)

**CAUTION**
The U3800A IoT Development Kit may experience performance degradation due to connectivity loss with the Edison chipset when electrostatic discharge (ESD) occurs at levels that exceed 4 kV.

ESD precautions should be taken when handling the device.
## Regulatory Markings

<table>
<thead>
<tr>
<th>Marking</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FCC</strong></td>
<td>The FCC label or the FCC mark is a certification mark employed on electronic products manufactured or sold in the United States which certifies that the electromagnetic interference from the device is under limits approved by the Federal Communications Commission.</td>
</tr>
<tr>
<td><strong>CE</strong></td>
<td>The CE mark is a registered trademark of the European Community. This CE mark shows that the product complies with all the relevant European Legal Directives.</td>
</tr>
<tr>
<td><strong>ISM GRP.1 Class A</strong></td>
<td>ISM GRP.1 Class A indicates that this is an Industrial Scientific and Medical Group 1 Class A product.</td>
</tr>
<tr>
<td><strong>ICES/NMB-003</strong></td>
<td>ICES/NMB-003 indicates that this ITE device complies with the Canadian ICES-003. Cet appareil ITE est conforme à la norme NMB-003 du Canada.</td>
</tr>
<tr>
<td><strong>401</strong></td>
<td>This symbol indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product.</td>
</tr>
<tr>
<td><strong>ICES-3 (B) / NMB-3 (B)</strong></td>
<td>ICES/NMB-3 indicates that this ISM device complies with the Canadian ICES-3. Cet appareil ISM est conforme à la norme NMB-3 du Canada.</td>
</tr>
<tr>
<td><strong>Complies with IMDA standards DA103861</strong></td>
<td>This label indicates that this product complies with IMDA standards DA103861.</td>
</tr>
<tr>
<td><strong>RCM</strong></td>
<td>The RCM mark is a registered trademark of the Australian Communications and Media Authority.</td>
</tr>
<tr>
<td><strong>R-NZ</strong></td>
<td>The R-NZ mark is the compliance mark of New Zealand radio communication standard.</td>
</tr>
<tr>
<td><strong>Certification mark</strong></td>
<td>Certification mark indicates a product has been certified by appointed Certifying Agency (SIRIM QAS International) as meeting MCMC Technical Codes (TC) that applied to the product.</td>
</tr>
</tbody>
</table>

The U3800A IoT Development Kit complies with the WEEE Directive (2002/96/EC) marking requirement. This affixed product label indicates that you must not discard this electrical or electronic product in domestic household waste.

Product category

With reference to the equipment types in the WEEE directive Annex 1, this device is classified as a “Monitoring and Control Instrument” product.

The affixed product label is as shown below.

Do not dispose in domestic household waste.

To return this unwanted device, contact your nearest Keysight Service Center, or visit http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more information.
Sales and Technical Support

To contact Keysight for sales and technical support, refer to the support links on the following Keysight websites:

- Product-specific information and support, software and documentation updates
  - www.keysight.com/find/U3801A
  - www.keysight.com/find/U3802A
  - www.keysight.com/find/U3803A
  - www.keysight.com/find/U3804A
  - www.keysight.com/find/U3805A
  - www.keysight.com/find/U3806A
  - www.keysight.com/find/U3807A
  - www.keysight.com/find/U3808A

- Worldwide contact information for repair and service
  - www.keysight.com/find/assist
Table of Contents

Environmental Conditions .................................................... 3
Regulatory Information ......................................................... 3
Regulatory Markings .............................................................. 6
Product category ................................................................. 7
Sales and Technical Support .................................................... 8
Overview .............................................................................. 11
U3800A IoT Development Kit ................................................ 12
Button Functions ................................................................. 13
U3800A Default Jumper Settings ............................................ 14
Main Jumpers ....................................................................... 14
Jumpers Function ................................................................. 15
System and Installation Requirements ..................................... 17
Characteristics and Specifications .......................................... 17
Setup ................................................................................. 18
Install Intel Edison USB driver ............................................. 18
Install PuTTY ......................................................................... 18
Log In to U3800A Using Serial COM Port ............................ 19
Set Up Virtual Ethernet link (RNDIS) .................................... 21
Flash Intel Edison Firmware ................................................. 23
Install XCTU Configuration Tool ......................................... 25
Install WinSCP Software ...................................................... 25
Auto Boot Up Display Setup .................................................. 27
Install Intel System Studio IoT Edition Software .................. 29
Verification .......................................................................... 42
Procedure ............................................................................ 42
Troubleshooting .................................................................... 47
Perform USB Port Test ......................................................... 47
Perform Micro SD Card Test .................................................. 49
Reset Docker Virtual Machine ........................................ 50
VMWare and Other Virtual Machine Management Software ...... 53
Soft Resetting U3800A IoT Development Kit ........................ 53
Appendix .................................................................. 54
Keysight U3800A Pins .................................................... 54
Radio Frequency Modules .............................................. 56
Overview

Keysight U3800 Series IoT Applied Courseware is a ready-to-teach package that covers the following:

1  **IoT Fundamentals (U3801A, U3802A)**
   Introduces the fundamentals of IoT. Students who complete this course will demonstrate the understanding of IoT’s architecture, technologies, standards, wireless protocols, applications, and ecosystems.

2  **IoT Systems Design (U3803A, U3804A)**
   Introduces IoT system design techniques, leveraging embedded systems and focusing on specific IoT examples. Students will learn how to design, develop, and evaluate an IoT-enabled embedded system using industry-standard tools.

3  **IoT Wireless Communications (U3805A, U3806A)**
   Allows students to develop typical IoT applications with various types of wireless connectivity. Students will be able to perform quick verification and design validation on these IoT applications.

4  **IoT Sensors and Power Management (U3807A, U3808A)**
   Teaches students how to characterize the power consumption of the IoT device’s on-board controller, sensors, and wireless modules. Students will understand the principles of power management and will be able to characterize micro electro-mechanical systems (MEMS) devices.

Each courseware comes with a training kit and teaching slides.

The training kit consists of the U3800A IoT Development Kit, IoT sensor device, XBee ZigBee kit, lab sheets, and problem-based assignments. The U3800A IoT Development Kit is a test accessory intended for students to carry out lab experiments as defined in the courseware.

Students can also use the training kit to develop their own projects once they have completed the courseware.
# U3800A IoT Development Kit

## Items and Their Corresponding Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jumper for ZigBee module (JP11)</td>
</tr>
<tr>
<td>2</td>
<td>ZigBee module</td>
</tr>
<tr>
<td>3</td>
<td>Analog connector (A0 to A5)</td>
</tr>
<tr>
<td>4</td>
<td>Analog pins (test points)</td>
</tr>
<tr>
<td>5</td>
<td>Analog/IO voltage reference jumper</td>
</tr>
<tr>
<td>6</td>
<td>OTG jumper</td>
</tr>
<tr>
<td>7</td>
<td>USB1</td>
</tr>
<tr>
<td>8</td>
<td>USB2</td>
</tr>
<tr>
<td>9</td>
<td>Jumpers (JP2 to JP6)</td>
</tr>
<tr>
<td>10</td>
<td>12 VDC power adapter port</td>
</tr>
<tr>
<td>11</td>
<td>Buttons (B1 to B4)</td>
</tr>
<tr>
<td>12</td>
<td>LCD display</td>
</tr>
<tr>
<td>13</td>
<td>SPI connector</td>
</tr>
<tr>
<td>14</td>
<td>I²C connector</td>
</tr>
<tr>
<td>15</td>
<td>Analog connector (A5 to A7)</td>
</tr>
<tr>
<td>16</td>
<td>UART1/UART2 jumper</td>
</tr>
<tr>
<td>17</td>
<td>Digital IO pins (test points)</td>
</tr>
<tr>
<td>18</td>
<td>Digital IO connectors</td>
</tr>
<tr>
<td>19</td>
<td>Intel Edison module</td>
</tr>
<tr>
<td>20</td>
<td>Jumper for Intel Edison module (JP12)</td>
</tr>
<tr>
<td>21</td>
<td>Micro SD card slot</td>
</tr>
</tbody>
</table>
### Button Functions

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
</table>
| **Power Button (PWR BTN)** | *Use to change Intel Edison power mode.*  
1 When the Intel Edison device is running, pressing and holding the power button for 10 seconds or more will cause the Intel Edison compute module to power down and leave the IO configuration in its current state.  
2 When the Intel Edison device is completely powered down, pressing and holding the power button for three seconds will power up the device and boot up the Intel Edison compute module.  
3 When the Intel Edison device is running, pressing and holding the power button for about two to seven seconds will put the Intel Edison device into AP (access point) mode. This action enables the "one-time setup" (same as configure_edison --enableOneTimeSetup). |
| **Reset Button (SYS RST)** | *Master Reset*  
1 Press and hold for eight seconds:  
Reset Intel Edison setting all the IO pins to high impedance state with no pull-ups.  
2 Press and hold for four seconds:  
Restart Intel Edison. |
U3800A Default Jumper Settings

**NOTE**

Power supply jumpers are in red on the U3800A board.

**CAUTION**

Do not hot swap any module (ZigBee, LoRa or Edison), sensors, or actuator switches when U3800A is power up and running. Doing so will damage the U3800A board.

### Main Jumpers

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Jumper Position</th>
<th>Jumper Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>MAIN</td>
<td>12 V DC Input Power Connector</td>
</tr>
<tr>
<td>JP11</td>
<td>XBEE</td>
<td>ZigBee Module Power Connector</td>
</tr>
<tr>
<td>JP12</td>
<td>EDSN</td>
<td>Edison Module Power Connector</td>
</tr>
<tr>
<td>JP15</td>
<td>SENSOR</td>
<td>Power Connector for Analog/ I²C / SPI</td>
</tr>
</tbody>
</table>
### Jumpers Function

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Jumper Position</th>
<th>Jumper Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP2</td>
<td>ED+RX</td>
<td>Edison UART1/UART2 Transmit to USB2 Receive</td>
</tr>
<tr>
<td></td>
<td>ED+XB</td>
<td>Edison UART1/UART2 Transmit to ZigBee Receive</td>
</tr>
<tr>
<td></td>
<td>XB+TX</td>
<td>USB2 Transmit to ZigBee Receive</td>
</tr>
<tr>
<td>JP3</td>
<td>ED+TX</td>
<td>USB2 Transmit to Edison UART1/UART2 Receive</td>
</tr>
<tr>
<td></td>
<td>ED+XB</td>
<td>ZigBee Transmit to Edison UART1/UART2 Receive</td>
</tr>
<tr>
<td></td>
<td>XB+RX</td>
<td>ZigBee Transmit to USB2 Receive</td>
</tr>
<tr>
<td>JP4</td>
<td>ED+XB</td>
<td>Edison UART1 RTS to ZigBee RTS</td>
</tr>
<tr>
<td></td>
<td>XB+RTS</td>
<td>ZigBee RTS to USB2 RTS</td>
</tr>
<tr>
<td>JP5</td>
<td>ED+XB</td>
<td>Edison UART1 CTS to ZigBee CTS</td>
</tr>
<tr>
<td></td>
<td>XB+CTS</td>
<td>ZigBee CTS to USB2 CTS</td>
</tr>
<tr>
<td>JP6</td>
<td>ED+XB</td>
<td>Edison UART1 DTR to ZigBee DTR</td>
</tr>
<tr>
<td></td>
<td>XB+DTR</td>
<td>ZigBee DTR to USB2 DTR</td>
</tr>
<tr>
<td>JP7</td>
<td>VREF+AREF</td>
<td>ADC Reference Voltage refer to AREF Voltage</td>
</tr>
<tr>
<td>JP7+JP8</td>
<td>IOREF + 3V3</td>
<td>3.3 V IO Voltage</td>
</tr>
<tr>
<td></td>
<td>IOREF + 5V</td>
<td>5.0 V IO Voltage</td>
</tr>
<tr>
<td>JP9</td>
<td>PWM1+5</td>
<td>PWM1 to Pin 5</td>
</tr>
<tr>
<td></td>
<td>PWM1+9</td>
<td>PWM1 to Pin 9</td>
</tr>
<tr>
<td></td>
<td>PWM3+9</td>
<td>PWM3 to Pin 9</td>
</tr>
<tr>
<td></td>
<td>PWM3+11</td>
<td>PWM3 to Pin 11</td>
</tr>
<tr>
<td>JP10</td>
<td>PWM0+3</td>
<td>PWM0 to Pin 3</td>
</tr>
<tr>
<td></td>
<td>PWM0+6</td>
<td>PWM0 to Pin 6</td>
</tr>
<tr>
<td></td>
<td>PWM2+6</td>
<td>PWM2 to Pin 6</td>
</tr>
<tr>
<td></td>
<td>PWM2+10</td>
<td>PWM2 to Pin 10</td>
</tr>
<tr>
<td>Jumper</td>
<td>Jumper Position</td>
<td>Jumper Function</td>
</tr>
<tr>
<td>--------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>JP16</td>
<td>UART1+RX</td>
<td>Edison UART1 Receive from USB2/ZigBee (JP2, JP3)</td>
</tr>
<tr>
<td></td>
<td>UART2+RX</td>
<td>Edison UART2 Receive from USB2/ZigBee (JP2, JP3)</td>
</tr>
<tr>
<td>JP17</td>
<td>UART1+TX</td>
<td>Edison UART1 Transmit to USB2/ZigBee (JP2, JP3)</td>
</tr>
<tr>
<td></td>
<td>UART2+TX</td>
<td>Edison UART2 Transmit to USB2/ZigBee (JP2, JP3)</td>
</tr>
<tr>
<td>JP18</td>
<td>OTG</td>
<td>Enable/ Disable OTG</td>
</tr>
</tbody>
</table>

RTS = Ready to Send  
CTS = Clear to Send  
DTR = Data Terminal Ready
System and Installation Requirements

PC operating system
- Windows 7, 8 or 10 (64-bit)

Interface
- USB (3 ports)

Characteristics and Specifications

For the characteristics and specifications of the U3800 Series IoT Applied Courseware, refer to the respective data sheet.
- U3800 Series IoT Applied Courseware
Setup

Install Intel Edison USB driver

1. Download the Intel Edison Driver software (IntelEdisonDriverSetup1.2.1.exe) from the link https://downloadcenter.intel.com/download/26993/Intel-Edison-Configuration-Tool

   Windows® 10*
   Windows 8*
   Windows 7*

   Language: English
   Size: 8.97 MB
   MD5: 1d039fe2f8b5b881eac058a2eadbdcf

   IntelEdisonDriverSetup1.2.1.exe

2. Download the FTDI driver setup software (CDM21226_Setup.zip) from the link http://www.ftdichip.com/Drivers/CDM/CDM21226_Setup.zip

3. Unzip the file and run the CDM21226_Setup.exe file to install and set up the FTDI driver.

4. Run the Intel Edison Driver Setup software file (IntelEdisonDriverSetup1.2.1.exe) to install the USB driver.

5. Perform the USB port test after installing the Intel Edison and FTDI drivers to ensure proper installation and working with the U3800A board. Refer to Perform USB Port Test section.

Install PuTTY

PuTTY is a terminal emulator, serial console, and network file transfer application.

1. Download Putty.exe from the link https://www.putty.org/.
Log In to U3800A Using Serial COM Port

1. Connect the micro USB cable from the development PC to the **USB2** port on the Keysight U3800A IoT Development Kit. This will power up the U3800A IoT Development Kit, and the LCD will display “Keysight U3800A” when the connection is successful.

2. Open **Device Manager** and **USB Serial Port (COM#n)** will be listed under **Ports (COM & LPT)** section. Take note of the USB serial port number (#n).

![Diagram of Keysight U3800A IoT Development Kit](image)
3. Execute the PuTTY software and set the configuration as shown below.
   a. Connection type: Serial
   b. Serial line: COM#n
   c. Speed: 115200

4. Click Open to connect to Keysight U3800A and log in.

5. Press Enter when you see a blank PuTTY screen. You should see a screen such as in the screenshot below.
Set Up Virtual Ethernet link (RNDIS)

1. Before you begin, ensure that you have installed the required drivers on the development PC mentioned in Setup.

2. Connect both USB ports on the Keysight U3800A IoT Development Kit to the development PC to power up the board.

3. From the Windows Control Panel, open Network Connections. Right click Intel Edison USB RNDIS Device #n and choose Properties.

5 Change the IP address to 192.168.2.2 and Subnet mask to 255.255.255.0. Click OK to exit.

NOTE Depending on the number of Edisons to configure, you will need to increase the IP address to allocate subsequent devices such as 192.168.2.3 and 192.168.2.4.

6 Execute the PuTTY software and set the configuration as shown below.
   a Connection type: SSH
   b Host Name (or IP Address): 192.168.2.15
   c Port: 22

7 Click Open to connect to Keysight U3800A and use root to log in.
Flash Intel Edison Firmware

**NOTE** This procedure is only necessary when Intel Edison firmware is corrupted. An example would be when you are no longer able to login to Intel Edison with your password.

1. Before you proceed, ensure that you have installed the necessary drivers on the development PC mentioned on page 18.


3. Download `dfu-util.exe` from the link http://dfu-util.sourceforge.net/releases/dfu-util-0.9-win64.zip.

4. Unzip the `dfu-util-0.9-win64.zip` file.

5. Unzip the Intel Edison Yocto Poky image into a folder.

6. Copy the `dfu-util.exe` and `libusb-1.0.dll` into the unzipped Intel Edison Yocto* Poky image folder.

7. Open Command Prompt.

8. Change the directory to the path of the unzipped folder from step 5. You can use the `cd` command as shown in the example below.
9. Unplug two USB cables from the U3800A board.

10. Run the batch command *flashall.bat* in the Command Prompt and it will show the following message.

![Command Prompt output](image1)

11. Plug two USB cables to the U3800A board to start the firmware flashing process automatically.

![Command Prompt output](image2)

**NOTE**
- Ensure the two USB cables are connected directly to the development PC.
- Ensure that drivers are installed correctly to work with the U3800A board before you perform USB Port Test.

12. Use PuTTY software to Log In to U3800A Using Serial COM Port.

13. Once logged in, run `cat /etc/version` command to verify the version of the FW flashed into the Intel Edison. It should be **201606061707**.

14. Run `pwd` command to verify that you are at `/home/root`. 
Run `ls` command to verify your `/home/root` folder is clean. It should be an empty folder.

Install XCTU Configuration Tool

XCTU is a configuration tool to set up, configure, and test the ZigBee module.

1. Download and install XCTU from the link below.
   https://www.digi.com/products/xbee-rf-solutions/xctu-software/xctu

2. Follow the instructions on the window to complete the installation.

Install WinSCP Software

WinSCP is an SFTP, FTP, WebDAV, and SCP client software to securely transfer files between a local PC and a remote PC.

1. Download and install WinSCP from the link below.
   https://sourceforge.net/projects/winscp/files/WinSCP/5.9.3/
   WinSCP-5.9.3-Setup.exe/download

2. Follow the instructions on the window to complete the installation.

3. Start WinSCP and set up the connection. Click Session > New Session.
4 Configure the WinSCP using the parameters below and click Login.

<table>
<thead>
<tr>
<th>Number</th>
<th>Parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File protocol</td>
<td>SFTP</td>
</tr>
<tr>
<td>2</td>
<td>Host name</td>
<td>192.168.2.15</td>
</tr>
<tr>
<td>3</td>
<td>Port number</td>
<td>22</td>
</tr>
<tr>
<td>4</td>
<td>User name</td>
<td>root</td>
</tr>
<tr>
<td>5</td>
<td>Password</td>
<td>xxx (if password has been set up, otherwise leave it blank.)</td>
</tr>
</tbody>
</table>

5 Drag the desired file from your PC to the /home/root folder of the U3800A IoT development kit.
Auto Boot Up Display Setup

1  Copy the startup.zip file to the micro SD card and extract the file.

   This procedure is only necessary when the LCD does not display the “Keysight U3800A" due to corrupted script in the Intel Edison.

   The startup.zip file can be found in the courseware materials folder. In order to access your courseware materials, log in to Keysight licensing website at www.keysight.com/find/softwaremanager.

2  Mount the micro SD card to DUT to U3800A micro SD card slot.

3  Connect USB1 and USB2 to development PC.

4  Log in to Yocto Linux remote terminal using PuTTY. (Refer to Verification, step 4 to 8)

5  Enter “cd /media/sdcard/startup” to change working directory to /media/sdcard/startup.

6  Execute “sh autodisplay.sh".
The setup is complete. Reboot U3800A and the LCD program will automatically run.
Install Intel System Studio IoT Edition Software

NOTE
The lab sheets for U3801A, U3802A, U3803A, and U3804A have been updated in which building the code file is now done by using on-board compiler. (Previously, Intel System Studio IDE is used). If you are using the latest version of lab sheets, this section is no longer applicable nor necessary.

1. Download Intel System Studio IoT Edition software from the link below.
https://downloadcenter.intel.com/download/26472?v=t

NOTE
Java is required to install Intel System Studio IoT Edition software.
2 Download Docker Toolbox software from the link below.
https://docs.docker.com/toolbox/toolbox_install_windows/

NOTE Docker Toolbox is different from Docker for Windows and is required for the IoT Applied Courseware. Docker Tool box is used for its compatibility to wider set of Windows OS versions.

3 Download Java SE Runtime Environment 8 software from the link below.
4 Download Java SE Development Kit 8 software from the link below.

5 Download 7zip software from the link below.
https://www.7-zip.org/download.html

6 Install 7zip software.

7 Install Java SE Runtime Environment 8 software into your Windows 10 PC. This is the installer with the filename "jre-8u161-windows-x64.exe".

8 Install Java SE Development Kit 8 software into your Windows 10 PC. This is the installer with the filename "jdk-8u161-windows-x64.exe".

9 Install Docker Toolbox software into your Windows 10 PC.

NOTE Always download the latest version of Java SE Runtime Environment 8 and Java SE Development Kit 8 software.
10 Run **Docker Quickstart Terminal** to start configuration. This will only happen the first time you run Docker Quickstart Terminal.

This step is important as you require the virtual machine running before running the Eclipse IDE. Refer to the **Troubleshooting** section if you encounter any problems starting the virtual machine.

You will see the following window when you have completed the configuration and when you run Docker Quickstart Terminal subsequently.

11 Type `exit` into the terminal to exit.

12 Extract the iss-iot-win_12-09-16.7z to your C drive of your Windows 10 PC (C:\).

   i Open **iss-iot-win_12-09-16.7z** with 7zip software.
Select the `iss-iot-win` folder and click the **Extract** button.

13 Run **Docker Quickstart Terminal** and leave it running.

**NOTE** Refer to the **Troubleshooting** section if you encounter any problems running the Docker.
14 Go to C:\iss-iot-win and run iss-iot-launcher.bat to start the Eclipse IDE.

15 When the Eclipse IDE is up and running, you may observe the following error message if you do not have the correct JDK installed:

Click OK to proceed. From the main Eclipse IDE window, click Window > Preferences > Java > Installed JREs.
17 Add your installed JDK path into the setting by using the Search button and browse to C:\Program Files\Java and click OK. Select or check the JDK option.

18 From the Eclipse IDE main window, go to Intel® IoT › Manage installed development platforms.
19 Select Intel® Edison and click Start. Note that when you select Intel Edison, the Platform support manager will also select other related dependencies.

Upon successful installation, you should see ‘Installed’ status as shown below:

20 Click Close to close the Platform support manager window.
Connect USB1 and USB2 of the Keysight U3800A to the PC.

Open **Network Connections** from the Windows Control Panel. Right-click **Intel Edison USB RNDIS Device #n** and choose **Properties**.
23 Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

24 Change the IP address to **192.168.2.2** and the Subnet mask to **255.255.255.0**. Click **OK** to exit.

25 From the Eclipse IDE main window, go to **Intel® IoT > Create a Target Connection**. Configure the target connection with the following details and click **OK**.
26 Start a new project by selecting **Intel IOT > Create an IoT Project**.

i Select **Intel Edison**.

ii Click **Next** to accept the target OS of Yocto Linux.

iii Select **Intel IoT C/C++ project**.

iv Accept the SSH target connection setting and click **Next**.

![Image of the project creation interface](image)

v Select the project example: **C>Basic>Hello World**

vi Click **Finish**.

vii Click **OK** to proceed if you did not set any password to your Keysight U3800 IoT SSH login.

![Image of the password entry interface](image)

Every time after the code compiles, Eclipse will send the compiled code to the Intel Edison module to execute it. This is done through the SSH protocol.
27 Set up this configuration to make sure the compiler uses the MRAA library.
   i. Go to Project > Properties > C/C++ Build > Settings.
   ii. In the Tool Settings tab, go to IoT Poky 32-Bit GCC Linker > Libraries.
   iii. Add a library mraa.

28 Copy and paste the C code from the lcd_test.zip file to the main.c file:

   The lcd_test.zip file can be found in the courseware materials folder. In order to access your courseware materials, log in to Keysight licensing website at www.keysight.com/find/softwaremanager.

29 Save the project.

30 Select Project > Build All to compile the code.
Select **Run > Run** to execute the code in the Keysight U3800A. You should be able to see an animation displayed on the LCD.

The MRAA library supports low level IO and communication in Embedded Linux. It can work with any platform with port names/numbering that matches the board that you are using. Throughout this courseware, you will use MRAA library to access low level GPIO and communication in the Intel Edison module.

Proceed to synchronize the packages between the target (U3800) and host (PC) when you are asked to do so as shown below.
Verification

Required equipment
- Keysight U3800A IoT Development Kit

Required accessories and software
- Micro USB cables
- Micro SD card
- PuTTY or Teraterm or any equivalent software to access serial port

Procedure

1. Copy the QSG.c file to the micro SD card and extract the file.

   The QSG.c file can be found in the courseware materials folder. In order to access your courseware materials, log in to Keysight licensing website at www.keysight.com/find/softwaremanager.

2. Insert the micro SD card into the micro SD card slot.

   Insert Micro SD card before powering on the U3800A IoT Development Kit.
3 Connect the micro USB cable from the PC to the **USB2** port of the U3800A IoT Development Kit. The LCD will show “Keysight U3800A” when the connection is established.

4 Open **Device Manager** and **USB Serial Port (COM\#n)** is listed under the **Ports (COM & LPT)** section. Take note of the USB serial port number (**#n**).
5 Execute the PuTTY file and set the configuration as shown below.
   a Connection type: Serial
   b Serial line: COM#n
   c Speed: 115200

6 Select Open to save the configuration and run the PuTTY terminal.
7 At the PuTTY terminal window, press Enter to load the PuTTY terminal.
8 Enter “root” at the edison login: line and press Enter to log in to Intel Edison module.
9 Enter “cd /media/sdcard” at the root@edison:~# line and press Enter to change the current directory to micro SD card.
10 Enter “ls” and press Enter to view the micro SD content.
11 Enter “g++ QSG.c -lmraa -o qsg” and press Enter to build the lcd sample program. Ignore the warning message if prompted.
12 Enter "./qsg" and press Enter to run the test program.

13 Press the B1 button and "Hello World" will be displayed on the LCD.
14 Press the B2 button and “Keysight U3800A” will be displayed on the LCD.

15 Press the B3 button and “QSG Quick Test” will be displayed on the LCD.

16 Press the B4 button and “Goodbye” will be displayed on the LCD.
Troubleshooting

Perform USB Port Test

To troubleshoot the USB ports on the U3800A, perform the following steps.

1. Connect the micro USB cables from the PC to the **USB1** port. LED1 and LCD display will light up once connection is established.

2. Open the **Device Manager**.
   “Intel Edison USB Composite Device” and “Intel Edison Virtual Com Port” will be listed under the **Ports (COM & LPT)** section.

3. Unplug the micro USB cable from the **USB1** port and plug in to the **USB2** port.

4. Open **Device Manager**.
   The **USB Serial Port** will be listed under the **Ports (COM & LPT)** section.
5 Observation:

<table>
<thead>
<tr>
<th>Result</th>
<th>Observation</th>
<th>USB1</th>
<th>USB2</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED1, LCD light up</td>
<td>Yes/No</td>
<td>Yes/No</td>
<td></td>
</tr>
<tr>
<td>Display on Device Manager:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intel Edison USB Composite Device,</td>
<td>Yes/No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intel Edison Virtual Com Port</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display on Device Manager:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Serial Port</td>
<td>-</td>
<td>Yes/No</td>
<td></td>
</tr>
</tbody>
</table>

6 Based on your observation, perform the following troubleshooting steps one at a time.

<table>
<thead>
<tr>
<th>Observation</th>
<th>Troubleshooting steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED1 and LCD display do not light up</td>
<td>1 Unplug the micro USB cable from USB1/USB2 port and plug in the cable again.</td>
</tr>
<tr>
<td>Missing USB serial port in the Device Manager</td>
<td>2 Connect the micro USB cable to another USB port in the PC.</td>
</tr>
<tr>
<td></td>
<td>3 Change the micro USB cable to another micro USB cable.</td>
</tr>
<tr>
<td></td>
<td>1 Ensure that all the jumpers (JP2–JP6, JP12) are at the default position.</td>
</tr>
<tr>
<td></td>
<td>2 Refer to “Install Intel Edison USB driver” on page 18 to install the USB driver if it is not already installed.</td>
</tr>
<tr>
<td></td>
<td>3 Unplug the micro USB cable from USB1 port and plug it in again.</td>
</tr>
<tr>
<td></td>
<td>4 Connect the micro USB cable to another USB port in the PC.</td>
</tr>
<tr>
<td></td>
<td>5 Change the micro USB cable to another micro USB cable.</td>
</tr>
</tbody>
</table>
Perform Micro SD Card Test

To troubleshoot the micro SD card, perform the following steps.

1. Perform steps 1 to 10 of the Verification procedure.
2. Based on your observation, perform the following troubleshooting steps.

<table>
<thead>
<tr>
<th>Observation</th>
<th>Troubleshooting steps</th>
</tr>
</thead>
</table>
| Unable to access Intel Edison via PuTTY terminal | 1. Connect USB2 to the PC and repeat steps 2 to 10 of Verification procedure.  
2. Open Device Manager to verify the serial port (COM#n). If the serial port is not available, refer to "Perform USB Port Test" on page 47 for troubleshooting options. Repeat steps 2 to 10 of the Verification procedure.  
3. Reset the PuTTY configuration as shown in step 5. Repeat steps 2 to 10 of the Verification procedure. |
| Unable to access the 'edison login' at the PuTTY terminal | Ensure that all the jumpers (JP2-JP6, JP12) are at the default position. Repeat Step 2 to 10 of Verification procedure. |
| Unable to display the micro SD card content | 1. Unplug the micro USB cables and remove the micro SD card from the U3800A IoT Development Kit. Repeat steps 2 to 10 of the Verification procedure.  
2. Change the micro USB cables to another micro USB cable and repeat steps 2 to 10 of the Verification procedure.  
3. Format the micro SD card and repeat steps 1 to 10 of the Verification procedure.  
4. Replace the micro SD card and repeat steps 1 to 10 of the Verification procedure. |
| Unable to join mobile hotspot network using Intel Edison | Create a mobile hotspot network with a network SSID using only alphanumeric characters. Avoid using characters such as `\<>+-~. |
| Serial port disappears intermittently from the Device Manager due to unstable connection | 1. Install FTDI drivers on your PC. Refer Install Intel Edison USB driver for more details.  
2. Connect USB cables to the U3800A board and PC.  
3. Ensure that USB cables are in good condition. |
Reset Docker Virtual Machine

1. Close **Docker Quickstart Terminal** if it is still running.
2. Run **Windows Task Manager** and look for the following background running software.

   ![Task Manager Screenshot](image)

   - VBoxHeadless.exe
   - VBoxHeadless.exe
   - VBoxHeadless.exe
   - VBoxNetDHCP.exe
   - VBoxNetDHCP.exe
   - VBoxHeadless.exe
   - VBoxHeadless.exe
   - VBoxHeadless.exe
   - VBoxHeadless.exe

3. Right click and click **End task** for all VBox related processes.

   ![Task Manager Screenshot](image)
4 Close the Task Manager and go to C:\Users\<username>\.docker\machine\machines using Windows Explorer. Delete the default folder.

5 Go to C:\Users\<username> and delete .VirtualBox folder.
6 Run Oracle VM VirtualBox.

7 Run Docker Quickstart Terminal.
Observe that a virtual machine will be created and it will appear in the Oracle VM VirtualBox Manager. Once the Docker Quickstart Terminal successfully launched, you would see that the virtual machine is running.

8 Close the Oracle VM VirtualBox Manager.
VMWare and Other Virtual Machine Management Software

Docker Toolbox is using Oracle VirtualBox as the virtual machine manager to run a Yocto Linux virtual machine on your PC. If you have any other virtual machine management software (such as VMWare) running on your PC, it might interfere with the virtual network created by VirtualBox. The Eclipse IDE might not able to connect properly with the U3800 training kit.

You are required to uninstall any other virtual machine management softwares on your PC to avoid issues running the Eclipse IDE that comes with the Intel System Studio IoT Edition.

Soft Resetting U3800A IoT Development Kit

This script automates the removal of all files in /home/root folder and reset the U3800 startup script to default. If there are any modifications done on the startup script, it will be reset to factory default. Running this script will reset the U3800/home/root folder and startup script back to default at the end of the lab session.

1. Copy the U3800 Soft Reset.zip file into your PC.
2. Extract all the files out and copy them to "/root" folder of the U3800 using WinSCP.
3. Log in to U3800 through SH or serial.
4. Change the working directory to cd /root
5. Run the U3800 soft reset script by sh u3800_soft_reset.sh
6. Reboot and log in.
### Keysight U3800A Pins

<table>
<thead>
<tr>
<th>Shield pin</th>
<th>Sensor pin</th>
<th>ZigBee pin</th>
<th>LCD pin</th>
<th>Pushbutton pin</th>
<th>MRAA Number</th>
<th>GPIO</th>
<th>Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DOUT</td>
<td></td>
<td></td>
<td></td>
<td>26</td>
<td>130</td>
<td>Digital I/O, UART1 Receive (RX)</td>
</tr>
<tr>
<td>1</td>
<td>DIN</td>
<td></td>
<td></td>
<td></td>
<td>35</td>
<td>131</td>
<td>Digital I/O, UART1 Transmit (TX)</td>
</tr>
<tr>
<td>2</td>
<td>CTS</td>
<td></td>
<td></td>
<td></td>
<td>13</td>
<td>128</td>
<td>Digital I/O, UART1 Clear to Send (CTS)</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>20</td>
<td>12</td>
<td>Digital I/O, Pulse Width Modulation [PWM0 (Jumper Setting: JP10-3 to JP10-PWM0)]</td>
</tr>
<tr>
<td>4</td>
<td>RTS</td>
<td></td>
<td></td>
<td></td>
<td>25</td>
<td>129</td>
<td>Digital I/O, UART1 Ready to Send (RTS)</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>51</td>
<td>41</td>
<td>Digital I/O</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>38</td>
<td>43</td>
<td>Digital I/O</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>50</td>
<td>42</td>
<td>Digital I/O, I2S2 Receive Data</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>37</td>
<td>40</td>
<td>Digital I/O, I2S2 Clock</td>
</tr>
</tbody>
</table>

---

54 Keysight U3800 Series Getting Started Guide
<table>
<thead>
<tr>
<th>Shield pin</th>
<th>Sensor pin</th>
<th>ZigBee pin</th>
<th>LCD pin</th>
<th>Pushbutton pin</th>
<th>MRAA Number</th>
<th>GPIO</th>
<th>Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 0</td>
</tr>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 1</td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 2</td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 3</td>
</tr>
<tr>
<td>A4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 4</td>
</tr>
<tr>
<td>A5</td>
<td>A5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 5</td>
</tr>
<tr>
<td>SDA</td>
<td>SDA</td>
<td>8</td>
<td>28</td>
<td></td>
<td></td>
<td>I2C6 Data (SDA)</td>
<td></td>
</tr>
<tr>
<td>SCL</td>
<td>SCL</td>
<td>6</td>
<td>27</td>
<td></td>
<td></td>
<td>I2C6 Clock (SCL)</td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 6</td>
</tr>
<tr>
<td>A7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Analog Input 7</td>
</tr>
<tr>
<td>CS</td>
<td></td>
<td>9</td>
<td>111</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, SPI2 Slave Select 0</td>
</tr>
<tr>
<td>CLK</td>
<td></td>
<td>10</td>
<td>109</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, SPI2 Transmit Data</td>
</tr>
<tr>
<td>MOSI</td>
<td></td>
<td>11</td>
<td>115</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, SPI2 Receive Data</td>
</tr>
<tr>
<td>MISO</td>
<td></td>
<td>24</td>
<td>114</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, SPI2 Clock</td>
</tr>
<tr>
<td>SDA</td>
<td></td>
<td>7</td>
<td>20</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, I2C1 Data</td>
</tr>
<tr>
<td>SCL</td>
<td></td>
<td>19</td>
<td>19</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, I2C1 Clock</td>
</tr>
<tr>
<td>RST</td>
<td></td>
<td>36</td>
<td>14</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O</td>
</tr>
<tr>
<td>DOUT*</td>
<td></td>
<td>44</td>
<td>134</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, UART0 Receive (RX)</td>
</tr>
<tr>
<td>DIN*</td>
<td></td>
<td>4</td>
<td>135</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital I/O, UART0 Transmit (TX)</td>
</tr>
<tr>
<td>DTR</td>
<td></td>
<td>31</td>
<td>44</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital Output</td>
</tr>
<tr>
<td>B1</td>
<td></td>
<td>33</td>
<td>48</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital Input</td>
</tr>
<tr>
<td>B2</td>
<td></td>
<td>46</td>
<td>47</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital Input</td>
</tr>
<tr>
<td>B3</td>
<td></td>
<td>32</td>
<td>46</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital Input</td>
</tr>
<tr>
<td>B4</td>
<td></td>
<td>45</td>
<td>45</td>
<td></td>
<td></td>
<td>-</td>
<td>Digital Input</td>
</tr>
</tbody>
</table>

Keysight U3800 Series Getting Started Guide
NOTE

No pull-up or pull-down resistor is interfaced to the IO Pin. The user may be required to add a resistor based on an external device that is interfacing with the U3800A.

Certain sensor modules may require an external pull-up or pull-down resistor to ensure the signal is pulled to a valid logical level, which is either a high or low state that can be recognized by the voltage level shifter, TXS0108, used in the U3800A.

Radio Frequency Modules

<table>
<thead>
<tr>
<th>Radio Modules</th>
<th>Frequency</th>
<th>Maximum Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edison - WLAN</td>
<td>2.4 and 5 GHz</td>
<td>17.1 dBm</td>
</tr>
<tr>
<td>Edison - Bluetooth®</td>
<td>2.4 GHz</td>
<td>5.4 dBm</td>
</tr>
<tr>
<td>Xbee ZigBee</td>
<td>2.4 GHz</td>
<td>5 dBm</td>
</tr>
<tr>
<td>SensorTag (CC2650)</td>
<td>2.4 GHz</td>
<td>5 dBm</td>
</tr>
</tbody>
</table>